
A new standard in 
professional layout  
and design

Frequently Asked Questions

®

Mac OS X, version 10.2.8–10.3.8/Microsoft® Windows® 2000/Windows XP

Product Basics
Q. What is Adobe InDesign CS2?
A. Adobe InDesign CS2 software is the latest major release of Adobe InDesign, a new standard in professional 
layout and design. Since its first release, Adobe InDesign software has always had a clear goal: Break down 
barriers in the creative workflow. With each release of InDesign, we’ve addressed entrenched problems 
in the design process by listening to customers and giving them the solutions they needed. Through this 
intense focus, InDesign has delivered landmark innovations in creative and production workflows. Today 
InDesign is a component of Adobe Creative Suite, which is transforming the way designers work. And 
major magazines, newspapers, book publishers, advertising agencies, graphic design firms, and corporate 
creative groups worldwide have switched their layout and design to InDesign to achieve significantly higher 
productivity and more refined creative results.   

Now Adobe InDesign CS2 celebrates five years of technology leadership by once again fine-tuning the 
page layout workflow to make it easier, faster, more fluid and versatile. From fulfilling designers’ desire for 
more control over Adobe Photoshop® files to vastly improving its text handling capabilities and evolving its 
XML support to better meet a range of publishing needs, Adobe InDesign continues to fulfill its promise to 
deliver more creative options, more productivity, and better ways to work. It also delivers a flexible, power-
ful platform for a wide variety of design and publishing solutions.

Q. Who should use Adobe InDesign CS2?
A. InDesign CS2 is designed for high-end graphic designers, production artists, and print professionals who 
work in magazines, design firms, advertising agencies, newspapers, book publishers, retail/catalog companies, 
service provider businesses, and other leading-edge publishing and print production environments. 

Note We encourage high-end graphic designers and production artists who use Adobe PageMaker® to switch 
to InDesign CS2 and offer special upgrade pricing just for these customers. Please see pages 3 and 5 for details. 

Q. Who is using Adobe InDesign today?
A. Many leading design firms, advertising agencies, magazines, newspapers, publishers, and brand-sensitive 
companies worldwide—as well as many of the world’s largest printers—have switched to InDesign improve 
their productivity and achieve better creative results. The list of who’s using InDesign is too lengthy to capture 
here. However, check out some of our customer case studies at www.adobe.com/indesign to get a representa-
tive sample of who’s using InDesign today. 

Q. What is Adobe Creative Suite 2?
A. Adobe Creative Suite 2 is the next generation upgrade to Adobe’s creative professional software. It’s a 
unified design environment that combines full new versions of Adobe Photoshop CS2, Illustrator® CS2, 
InDesign CS2, GoLive® CS2, and Acrobat® 7.0 Professional software with enhanced Version Cue® CS2 file 
manager, new Adobe Bridge visual file browser, and new Adobe Stock Photos. New features also include 
the ability to manage color settings centrally and common Adobe PDF settings. Delivering the next level of 
integration in creative software, Adobe Creative Suite 2 enables you to realize your ideas anywhere—in print, 
on the Web, or on mobile devices. 

Note Adobe Creative Suite 2 is available in two versions: Premium Edition and Standard Edition. Adobe 
Creative Suite Premium Edition is described above. The Standard Edition combines all of the components 
listed above, except GoLive CS2 and Acrobat 7.0 Professional. 

Adobe® InDesign®  CS2
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Q. Can I still buy InDesign CS2 as a standalone product?
A. Yes, InDesign CS2 is available to license as a standalone product for both new and upgrade customers. 
For more information about pricing, see the “Pricing and Availability” section later in this document.

Q. Is there any difference between the standalone version of InDesign CS2 and what’s included in 
Adobe Creative Suite 2 Premium or Standard Edition?
A. No, there is no difference in features, functionality, or included content between InDesign CS2 as a stand-
alone product and InDesign CS2 in Adobe Creative Suite 2, except for Adobe Bridge. In the suite, Adobe 
Bridge gives you access to suite-only features that aren’t available in the standalone products, including 
Version Cue CS2, Bridge Center for easier access to projects and information, and the ability to synchronize 
color settings across the components of the suite.

Q. What are the top 10 new features in Adobe InDesign CS2?
A. Adobe InDesign CS2 is packed with new features, which are described in detail in What’s New in Adobe 
InDesign CS2, which you can find on www.adobe.com/indesign. The top 10 new features are:

• Adobe Bridge Browse, organize, label, and preview graphics, as well as InDesign documents, templates, and 
snippets. Drag and drop assets from Adobe Bridge into layouts more easily and efficiently. Search for files 
using metadata, such as keywords, colors, and fonts used. 

• Object styles Apply and globally update object-level formatting more efficiently using object styles. Save a 
wide range of graphic, text, and frame-level attributes as object styles to create more consistent designs and 
speed up production tasks.

• Control visibility of layers in Adobe Photoshop and PDF files Selectively display layers and layer comps in 
Photoshop files, and layers in Adobe PDF files, to experiment with different design options or use multiple 
variations of a file in your layout—all while linking to a single file.

• InDesign snippets Easily export InDesign objects as snippets, which can be shared with colleagues or reused 
in other documents. When you place or drag a snippet into a layout, InDesign recreates the original objects, 
their formatting, and their relative positioning on the page. 

• Tighter integration with Adobe® InCopy® CS2 Collaborate more closely with editors through the new Adobe 
InCopy CS2 LiveEdit workflow, which enables designers and editors to work in parallel on an InDesign 
layout without overwriting each other’s changes. With the new assignments workflow, you can break up 
access to documents among multiple editors by assigning only those elements that different editors need to 
work on—whether that’s specific frames on a page, on one or more spreads, or across a document. 

• Ability to open InDesign CS2 files in InDesign CS Export your InDesign CS2 document to the InDesign Inter-
change format (INX) to share with people still working in InDesign CS. For more information, see page 7. 

• Anchored objects Easily anchor callouts, pull quotes, margin notes, and graphics to text. Precisely control 
the positioning of anchored objects, apply text wrap settings, and more. 

• Significantly enhanced Microsoft Word/RTF import filter Automatically style Microsoft Word files on import 
by mapping Word styles to InDesign styles. Also resolve style name conflicts at import, preserve local over-
rides while removing other formatting, and save Word import settings as presets for future use. 

• Smart text handling Drag and drop text within and between text frames, tables, views, and documents. 
Automatically strip the original formatting from copy as you paste it, so that the pasted text will inherit the 
formatting applied at its new location. Preview fonts in WYSIWYG font menus. 

• Enhanced XML support Import XML files using enhanced import options, which give you flexible control 
and make it easier to achieve the results you want. Create a link to an XML file on import for easier updat-
ing. Apply XML tags to InDesign tables, and then import XML content into or export it from those tables.

Q. What is Adobe Bridge?
A. Adobe Bridge, which is included with the standalone version of InDesign CS2 and as a component of 
Adobe Creative Suite 2, is a visual file browser and a hub for productivity in both InDesign and the suite. 
You can run it independently or access it from within InDesign CS2, Illustrator CS2, Photoshop CS2, and 
GoLive CS2. Adobe Bridge allows you to efficiently organize, browse, and locate the assets they need to 
create content for print, Web, and mobile. Adobe Bridge is also the primary interface for Version Cue CS2 
file manager and includes access to the new Adobe Stock Photos service. (It is not available for purchase as a 
standalone product itself.) For more information, visit www.adobe.com/creativesuite.  
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Q. What is Adobe Stock Photos?
A. Adobe Stock Photos, accessible from within Adobe Bridge, is an exciting new service that can help you 
get your creative ideas flowing. Offering one-stop shopping for high-quality, royalty-free stock images for 
your creative work, Adobe Stock Photos is a convenient way for you to view, try, buy, and manage stock 
photos from some of the world’s leading image libraries—or simply to get inspired. 

Q. Will Adobe continue to sell and support Adobe PageMaker® software? As a PageMaker user, 
should I be thinking about switching to InDesign?
A. Yes, Adobe continues to sell and support Adobe PageMaker® software for business, education,  
and small- and home-office professionals. However, we recommend that professional designers and produc-
tion artists who uses PageMaker be sure to try InDesign CS2. InDesign is a natural upgrade choice for you 
because you can get up to speed quickly with familiar Adobe tools, open your library of PageMaker docu-
ments (versions 6.0–7.x) in InDesign, and experience a new level of design power and control. Adobe offers 
special upgrade pricing for PageMaker users who switch to InDesign. See page 5 for details. 

Q. What happened to the Adobe InDesign PageMaker Edition and the Adobe PageMaker Plug-in 
Pack? Why aren’t these products still available?
A. We’ve incorporated all of the functionality first introduced in Adobe InDesign CS PageMaker Edition 
and the PageMaker Plug-in pack into InDesign CS2, so these separate products are no longer necessary. 
Both the InDesign CS PageMaker Edition and the PageMaker Plug-in Pack were originally created to help 
PageMaker users more easily make the switch to InDesign (users could either license the PageMaker Edi-
tion, or, if they’d already licensed InDesign CS, they could add on the PageMaker Plug-in Pack to make it 
match PageMaker Edition). Now InDesign CS2 includes these features as part of its core functionality, just 
for PageMaker users:

• Publication converter for PageMaker 6.0 files  Convert PageMaker 6.0 document and templates to 
InDesign CS2 format, and in some cases even fix damaged PageMaker files or open previously unopenable 
PageMaker files (with limitations). This capability expands the conversion support that has been available in 
InDesign since version 1.0: the ability to open PageMaker 6.5–7.x and QuarkXPress 3.3–4.x documents.

• InBooklet Special Edition (SE) plug-in  Automatically rearrange a document’s pages into printer spreads for 
professional printing with complete control over margins, gaps, bleeds, creep, and crossover traps—a process 
known as imposition. Choose among 2-up saddle stitch, 2-up perfect bound, and 2-, 3-, and 4-up consecutive.

• Automated bullets and numbering  Automatically create and style bulleted and numbered lists or save them 
as part of paragraph styles. Numbered lists update automatically when changes are made. 

• Data merge  Create customized publications, such as catalogs, direct mail campaigns, business cards, form let-
ters, and mailing labels by merging data from a spreadsheet or database into your InDesign layouts.

• Position tool  Resize and move images and their frames or reposition content in relation to frames using the 
handy Position tool, which works similarly to the Crop tool in PageMaker.

• PageMaker compatible keyboard shortcuts Work at peak efficiency by switching the keyboard shortcuts in 
InDesign CS2 to match the shortcuts you’ve already learned for PageMaker.

• PageMaker toolbar Enjoy easy access to commonly used commands through a Windows-style toolbar simi-
lar to ones used in Acrobat and Microsoft Word. Available for both Mac OS and Windows users.

In addition, InDesign also incorporates enhanced versions of other “must-have” features for PageMaker 
users, such as the Story Editor and Control palette.  

Q. How does InDesign CS2 work with other Adobe products?
A. Adobe InDesign CS2 is designed to integrate tightly with Adobe Photoshop CS2, Illustrator CS2, GoLive 
CS2, InCopy CS2, and Acrobat 7.0 Professional. InDesign CS2 shares common commands, palettes, tools, 
and keyboard shortcuts with Photoshop CS2, Illustrator CS2, and InCopy CS2—so it’s easy to apply what 
you know about one program to learning another and to move from program to program efficiently. It 
simplifies the workflow involved in laying out and updating graphics by importing native Photoshop and 
Illustrator files. And it imports and exports Acrobat 7.0, 6.0, 5.0, and 4.0 PDF files. InDesign CS2 and 
InCopy CS2 work together to provide robust editorial workflow management for small creative teams. The 
enhanced Package for GoLive command offers a compelling new, visually oriented workflow for designers 
who want to repurpose InDesign assets as Web pages in GoLive. 
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Q. What is Adobe InCopy and how is it relevant to InDesign users? 
A. Adobe InCopy CS2 software is a professional writing and editing program that integrates tightly with 
Adobe InDesign CS2 to deliver a complete solution for collaborative editorial workflow. It is designed to 
scale to the needs of small, medium, and large content publishers. A version of InCopy is available directly 
from Adobe for small workgroups. Medium-to-large publishers can acquire powerful editorial solutions 
based on InCopy CS2 and InDesign CS2 from third-party developers and systems integrators. 

InCopy CS2 for small workgroups includes editorial workflow technology that enables designers and edi-
tors to work on the same InDesign CS2 document simultaneously without interfering with each other’s 
work. InCopy CS2 gives editors 100% accurate information about line breaks and up-to-the-minute visual 
feedback about page design, so editors can copyfit text with complete insight into how the copy and design 
interact. This support for parallel workflows reduces the number of review and revision cycles, and ulti-
mately streamlines the time it takes to get publications to market. It also puts copy-fitting control back in 
the hands of editors who have more control over the integrity of their editorial content. For more informa-
tion, see www.adobe.com/incopy.

Q. How does InCopy CS2 differ from the Story Editor in InDesign CS2?
A. InCopy CS2 is a full editorial solution that’s designed to support more efficient workgroup publishing 
by giving designers and editors simultaneous access to the same InDesign layouts without fear of overwrit-
ing each other’s work. In addition, InCopy provides powerful customizable editorial tools and cross-media 
publishing support. In contrast, the Story Editor in InDesign provides excellent word-processing and copy-
fitting support for a single user working on an InDesign layout. 

Q. Why is InCopy CS2 only offered separately from Adobe Creative Suite 2?
A. Professional editors are the primary users of InCopy CS2 and generally don’t require the full 
functionality of Adobe Creative Suite 2, while the designers they work with do. As a result, it makes sense 
to offer InCopy and the suite separately. Designers can make full use of Adobe Creative Suite 2, while the 
editors they work with can easily integrate standalone InCopy CS2 with InDesign CS2 in a collaborative 
editorial workflow. 

Q. What is Adobe InDesign CS2 Server and who uses it?
A. Adobe InDesign Server CS2 is a new technology platform for third-party systems integrators and developers 
who build design-driven, server-based publishing solutions. It is the Adobe InDesign CS2 engine, with its innova-
tive design and typography features, adapted for server usage. This server technology will enable Adobe partners 
to provide new levels of automation and efficiency in high-end editorial workflows, collateral creation, variable 
data publishing, and web-based design solutions.

Adobe expects to launch a pilot program in the spring of 2005 to support an initial group of developers 
in designing and deploying customer solutions based on InDesign Server CS2. As a technology platform, 
InDesign Server will not be available directly from Adobe to end users but will instead be available to you 
through third parties who build and deliver a wide variety of publishing solutions. For more information, visit 
www.adobe.com/indesign.

Q. What is product activation?
A. Product activation is an interactive interpretation of the licensing agreement that has always existed between 
Adobe and its customers. The activation process authenticates licensed users without hindering their ability 
to use the software the way they have always done. It requires a series of simple, quick, anonymous steps upon 
product installation or within the grace period set by Adobe. Just as creative professionals use watermarks to 
protect their intellectual property, Adobe is using activation as a way to curtail unlicensed copying of its prod-
ucts. Adobe’s activation process is required on both Mac OS and Windows systems for standalone versions of 
InDesign CS2, Photoshop CS2, Illustrator CS2, GoLive CS2, and Acrobat 7.0 Professional, as well as for Adobe 
Creative Suite 2 Premium Edition and Standard Edition. For more information about activation, please see 
www.adobe.com/activation.
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Pricing and Availability
Q. How much will Adobe InDesign CS2 cost? How much will an upgrade cost?
A. The table below lists the estimated street prices for retail and upgrade versions of Adobe InDesign CS2 
(price excludes applicable taxes and shipping):

Region Retail Price (ESP) Upgrade Price (ESP) PageMaker Upgrade

U.S. and Canada $699 (U.S.) $169 (U.S.)   $349 (U.S.)

Europe 1129 € (Euros) 249 € (Euros)†   529 € (Euros)†

Japan ¥88,000 ¥25,000    ¥65,000

Rest of World (ROW) $699 (U.S.) $169 (U.S.)   $349 (U.S.)

Volume licensing options are also available. That information will be available on the Adobe Web site at www.adobe.com/store/
openoptions/main.html after the product is announced.

† Upgrades for Danish, Finnish, and Norwegian versions may be 5% higher. 

Q. How much will the standalone version of Adobe InCopy CS2 cost? How much will an upgrade to 
Adobe InCopy CS2 cost?
A. The table below lists the estimated street prices for retail and upgrade versions of Adobe InCopy CS2  
(price excludes applicable taxes and shipping). Please note that only users who purchased InCopy CS 
directly from Adobe can upgrade to InCopy CS2. If you purchased InCopy as part of a third-party system, 
you should contact that third party for upgrade information.

Region Retail Price (ESP) Upgrade Price (ESP)

U.S. and Canada $249 (U.S.) $89 (U.S.)  

Europe 419 € (Euros) 129 € (Euros) 

Japan ¥19,800 Not applicable    

Volume licensing options are also available. That information will be available on the Adobe Web site at www.adobe.com/store/
openoptions/main.html after the product is announced.

Q. As a PageMaker user, am I eligible for special pricing if I want to switch to InDesign?
A. Yes, licensed Adobe PageMaker users can upgrade to a full version of InDesign CS2, which now includes 
all of the features first introduced in the InDesign CS PageMaker Edition, for only $349 (U.S.), a cost-
effective upgrade path for PageMaker users who want to build on their existing creative expertise. Page-
Maker users can purchase the upgrade directly through the online Adobe store (www.adobe.com/store) or 
from any Adobe Authorized Reseller. To install the upgrade, you must have a valid serial number from any 
previous version of PageMaker. For more details, visit the Adobe Web site at www.adobe.com/indesign. 

Q. As a QuarkXPress user, am I eligible for special pricing if I want to switch to Adobe InDesign CS2?
A. There is no special pricing planned for switching from QuarkXPress to InDesign at this time. Any special 
promotions for QuarkXPress users will be highlighted on the Adobe Web site at www.adobe.com/indesign. 

Q. What does Adobe Creative Suite 2 cost? Can I upgrade to it?
A. Pricing for Adobe Creative Suite 2 depends on whether you’re licensing the Premium or Standard Edi-
tion and whether you’re  upgrading from a previous version of Adobe Creative Suite, from one of the Adobe 
Collections (Web, Design, Publishing, Digital Video, or Video Professional), or from Adobe Photoshop. For 
complete details, please see the FAQ for Adobe Creative Suite 2 at www.adobe.com/creativesuite. 

Q. Will an Education version of Adobe InDesign CS2 be available?
A. Yes. Education versions of Adobe software include all of the same features as retail versions but may not 
provide the “extras,” such as the clip art and stock photography included with InDesign CS2. Education ver-
sions are available through Adobe Authorized Education Resellers and are for use by Education End Users 
only. For more information, visit the Adobe Web site at www.adobe.com/education. 
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Q. Can I try Adobe InDesign CS2 before I purchase it?
A. Yes! A fully functional 30-day tryout version of Adobe InDesign CS2 will be available for download from the 
Adobe Web site not long after the product begins shipping. Until the InDesign CS2 tryout version is available, you 
may still download and work with the InDesign CS tryout version. Visit www.adobe.com/indesign for details.   

System Requirements
Q. What are the system requirements for Adobe InDesign CS2 on the Mac OS? on Windows?
A. The system requirements for InDesign CS2 are:

System Mac OS Windows

Processor PowerPC® G3, G4, or G5 processor Intel® Pentium® III or 4 processor 

Operating system Mac OS X (version 10.2.8–10.3.8) Microsoft® Windows® 2000 with Service  
Pack 3 or Windows XP 

RAM 256 MB (320+ MB recommended)   256 MB (320+ MB recommended)

Available hard-disk space 870 MB   850 MB  
for installation*

CD-ROM drive Yes Yes 

Monitor resolution 1024x768  monitor resolution with 1024x768 monitor resolution with   
 16-bit or greater video card 16-bit or greater video card 

PostScript® printer Adobe PostScript Level 2 or  Adobe PostScript Level 2 or  
 Adobe PostScript 3™ required  Adobe PostScript 3 required

Multimedia support QuickTime 6.0** or later installed QuickTime 6.0** or later installed

Product activation Internet or phone connection Internet or phone connection

Adobe Stock Photos† Broadband Internet connection Broadband Internet connection 

** During installation, you will need at least 500MB more free hard disk space for the installer to work properly. If you don’t 
have this space available, the installer will alert you. In addition, a portion of these files—Adobe common files such as Adobe 
Bridge or online Help—must be installed on your main hard drive. If you install on an external drive, the installer will install 
the application on the external drive and the Adobe common files on your main drive.

** Included with Mac OS X, v. 10.2.8–10.3.8, and available for free on the Apple Web site. 
† The Adobe Stock Photos service may not be available in all countries, languages, and currencies and is subject to change. Use 

of the service is governed by the Adobe Stock Photos Terms of Service. For details, visit www.adobe.com/adobestockphotos.

Q. Can I use Adobe InDesign CS2 or InCopy CS2 on Tiger (Mac OS X, version 10.4)?
A. At this time, Mac OS X version 10.4 has not yet been released, so compatibility testing for InDesign, 
InCopy, or Adobe Creative Suite 2 is not complete. For updated information once Tiger becomes publicly 
available, visit www.adobe.com/creativesuite.

Support for Making the Switch to InDesign CS2
Q. Is InDesign CS2 easy to learn?
A. Yes—if you already know Photoshop and Illustrator, you can get up to speed quickly with InDesign CS2 
just by applying that knowledge. In addition, you can find help mastering InDesign basics with Adobe 
InDesign CS2 Video Workshop, a free training CD created by Total Training (www.totaltraining.com) and 
included with all versions of InDesign—Retail, Upgrade, Education, and PageMaker Upgrade. (Adobe Cre-

ative Suite 2 users: See the Adobe Creative Suite 2 Video Workshop CD for similar hands-on training.) 

Q. What’s available to help QuarkXPress users make the switch to InDesign CS2?
A. Yes. You can, for example, switch the keyboard shortcuts in InDesign CS2 to match the ones in QuarkXPress 
using the Edit > Keyboard Shortcuts command. You can also open QuarkXPress 3.3–4.x files directly using 
the File > Open command. InDesign is able to map QuarkXPress layout elements to InDesign equivalents 
to preserve the look and feel of documents as closely as possible. An in-depth conversion guide for switching 
from QuarkXPress to InDesign is also available on the Adobe Web site at www.adobe.com/indesign.
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Q. What’s available to help PageMaker users make the switch to InDesign CS2?
A.  InDesign CS2 is a natural upgrade choice for PageMaker users, delivering innovative design and layout 
features that help you work smarter and faster on the latest Windows and Macintosh operating systems. 
It’s also designed to help you make the transition from PageMaker to InDesign as smoothly and rapidly as 
possible. You can, for example, apply what you know about PageMaker, Illustrator, and Photoshop to learn-
ing InDesign, which shares the common Adobe interface. You can switch the keyboard shortcuts InDesign 
to match those in PageMaker, so you don’t have to teach your fingers new tricks. You can open PageMaker 
6.0–7.x files as InDesign documents. And you can take advantage of InDesign features that address the 
needs of PageMaker users, including Story Editor, Control palette, data merge, automated bullets and num-
bering, InBooklet SE for imposition, and a PageMaker toolbar. In-depth conversion information is also 
available on the Adobe Web site at www.adobe.com/indesign.

Q. Is it possible to convert QuarkXPress 5.0–6.5 documents to InDesign CS2 format?
A. It is our understanding that Quark has chosen to encrypt the XPress 5.0 and 6.0 file formats. Because 
of this decision, InDesign CS2 cannot directly open and convert XPress 5.0 and 6.0 files. By contrast, the 
InDesign file format is not encrypted, so it better supports and adapts to a wide variety of workflows. 

Mac OS users: We know of one solution for converting your XPress 5.0–6.5 documents to InDesign. A 
third-party plug-in developer, MarkzWare (www.markzware.com), produces MarkzTools 5.5, a plug-in to 
QuarkXPress 4.x and 5.x for the Mac that can open your XPress 6.x files and save them back to XPress 4.x 
format. You can then open those files in Adobe InDesign CS, which is able to convert files from XPress 
3.3–4.x. Please note that new XPress 6.0 features may not be supported when you save backwards to 
QuarkXPress 4.x format. 

Windows users: Unfortunately, there are no solutions available at this time for Windows users of XPress 5.0 
or 6.0 to move their files to InDesign. Should any options become available in the future, we will provide 
information about those solutions on the Adobe website at www.adobe.com/indesign. 

Q. Quark offers free technical support in all English-speaking countries. Why doesn’t Adobe provide 
free technical support for InDesign?
A. All registered users of current Adobe desktop products are eligible for complimentary, person-to-person 
support on issues related to installation and product defects, including crashes and errors. For more infor-
mation about Adobe’s complimentary support, visit www.adobe.com/support/cfcomp.html. Adobe custom-
ers also have online access to Frequently Asked Support questions, the Support Knowledgebase, and online 
forums, where they can find answers to a wide range of product questions. 

In addition, Adobe offers Adobe Expert Support, a trio of paid support packages that:
• address the different technical needs of our creative professional and business customers by offering alterna-

tives instead of a one-size-fits-all approach to technical support. 
• deliver extended evening and weekend hours.
• provide access to Adobe experts who are trained in how Adobe products work together. 

With these offerings, customers can eliminate the time it takes to research in-depth issues, and instead get 
fast, priority access to Adobe experts for a reasonable fee. Providing high-quality support is expensive, and 
users end up paying for it one way or another. Many of our customers are self sufficient or have excellent 
in-house Help Desk services, so rolling support costs into product costs unfairly requires some customers to 
subsidize others. A pay-for-your-need approach enables us to provide the best quality support in a way that 
balances the interests of all of our customers.
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Q. Can I save InDesign CS2 files in a format that can open in InDesign CS?
A. Yes, you can. When you want to exchange InDesign CS2 files with someone who is still working in 
InDesign CS, you can export the file to InDesign Interchange (INX) format. Just choose File > Export, select 
the InDesign Interchange Format, and then click Save. A designer using InDesign CS can then open the 
file as long as they’ve installed an update to InDesign CS  called “InDesign 3.0.1 April 2005 (Compatibility 
Upgrade).” This update is available free of charge on the Adobe website: Visit www.adobe.com/indesign or 
go to the Downloads area at www.adobe.com/support/downloads. Note that some changes to your docu-
ment may occur because InDesign CS does not support all of the new features in InDesign CS2.  

Note about what’s happening behind the scenes The INX file preserves the content and geometry of the 
original InDesign CS2 file. When the INX file is opened in InDesign CS, it is read by the InDesign scripting 
engine which uses the data to accurately recreate the file (minus any InDesign CS2 data that isn’t supported 
by InDesign CS).  

Q. How do I find service providers who are experienced at printing InDesign files?
A. Visit partners.adobe.com/asn/partnerfinder. Then click Search for an ASN Service Provider, fill out the 
online form, and click Search. The Adobe Partner Finder enables you to search by product and metropolitan 
area to locate the InDesign printing support you need. If you do not find the service provider you need, you 
can e-mail Adobe for help. You can even request that Adobe provide information to your current service 
provider about how to work with InDesign files (we have comprehensive training information available). 

Q. How do I get my service provider business listed in the Adobe Partner Finder?
A. If you’re a service provider who outputs InDesign files and you’re not registered in the Adobe Partner 
Finder, visit partners.adobe.com/asn/partnerfinder today to register your services with us free of charge. It’s 
an easy, cost-effective way to connect with InDesign and other Adobe product customers in your area. 

Q. Where do I find trainers who will train on InDesign?
A. Many of Adobe’s ASN Training Providers support InDesign. Just visit partners.adobe.com/asn/partner-
finder. Then click Search for an ASN Training Provider, fill out the online form, and click Search. 

Q. What other training resources are available?
A. A wide variety of training tools for InDesign CS2 are available to suit different needs and tastes:
Books, training videos, and other resources  The first thing you should do is to visit the Adobe website 
at www.adobe.com/products/indesign/training.html for an overview of available training resources. We 
then recommend visiting online bookstores (www.amazon.com, www.barnesandnoble.com, or another 
online bookstore) to search for books about InDesign, as well as Total Training (www.totaltraining.com), 
Lynda.com (www.lynda.com), Element K (www.elementk.com), and others for video and online training.

InDesign User Groups  Keen on finding a local community of InDesign enthusiasts for ongoing learning and 
sharing of InDesign tips and tricks? InDesign User Groups meet regularly in many major cities in North 
America. For more information, visit www.indesignusergroup.com. 

InDesign Magazine  InDesign Magazine is the first bimonthly PDF periodical devoted entirely to Adobe 
InDesign and the growing community of InDesign professionals. With editorial direction by best-selling 
author David Blatner and creativepro.com, InDesign Magazine brings you the in-depth features, reviews, and 
tutorials you need to master Adobe InDesign. Visit www.indesignmag.com to subscribe to the magazine. 
Also visit www.indesignmag.com/idm/tipofweek.html to sign up for a free weekly InDesign tip. 

InDesign Conference  The InDesign Conference is an independent event, held several times a year in cities 
around the world, to provide in-depth InDesign training with a variety of well-known experts. For more 
information, visit www.theindesignconference.com. 
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Plug-ins for Adobe InDesign CS2
Q. Can you extend the capabilities in InDesign the way you can with Quark XTensions? 
A. Absolutely. InDesign is extensible by design. In fact, it epitomizes the modern, modular, object-oriented 
approach to programming that has evolved since QuarkXPress and PageMaker were first developed. Adobe 
InDesign provides a core application that defines both the object model and the interfaces that determine 
how objects behave. All of its type, color, printing, and other features are provided through plug-ins to this 
core application. Virtually every aspect of the program is a plug-in, giving third-party developers extraordi-
nary freedom in modifying InDesign and adding customized functionality. 

You can locate commercially available plug-ins, contract with freelance developers to create custom solu-
tions, or have your IT department develop any custom tools you need. To locate commercially available 
plug-ins, visit the Adobe Web site at www.adobe.com/products/plugins/indesign/main.html. To find a third-
party developer, visit the Adobe Partner Finder at www.adobe.com/asn/partnerfinder.

Q. Why are there more XTensions for QuarkXPress than there are plug-ins for InDesign? 
A. Adobe InDesign has a lot of features built in that are available in QuarkXPress only through retail or 
shareware XTensions, so InDesign has less need for additional plug-ins.   

Q. What plug-ins will be available for Adobe InDesign CS2?
A. We’re working with a variety of third-party developers to update or create new custom plug-ins for 
InDesign CS2. Information about specific plug-ins for InDesign CS2 will be available at www.adobe.com/
products/plugins/indesign/main.html after the product ships. 

Q. I want to develop plug-ins for Adobe InDesign CS2. Where do I start?
A. The Adobe Solutions Network (ASN) provides developers with high-quality tools, information, and ser-
vices to help you create plug-ins for InDesign and other Adobe products. We encourage developers to join 
ASN to receive timely product information, developer support, and access to prerelease software. ASN also 
offers developers the opportunity to participate in co-marketing activities. In addition, we host developer 
camps in the United States, Europe, and Japan to share information about new APIs, review SDK documen-
tation, and offer engineering assistance. While we encourage ASN membership, we do not require it for you 
to take advantage of in-depth technical information for developers. Approved developers can also receive 
Adobe Software Development Kits (SDKs) and Technical Notes. For more information, visit the ASN web-
site at partners.adobe.com/asn/developer/main.html. 

International Support
Q. In which languages will Adobe InDesign CS2 be available?
A. In addition to Universal English, Adobe InDesign CS2 will be available in these languages: Brazilian Por-
tuguese, Danish, Dutch, Finnish, French, German, Italian, Japanese, Norwegian, Spanish, and Swedish. It is 
also available for the first time in Traditional and Simplified Chinese and in Korean.

Note Winsoft is expected to release Central European (CE) and Middle Eastern (ME) versions of InDesign 
CS2. For more details, visit the WinSoft website at www.winsoft.fr.

Q. Are language dictionaries included with Adobe InDesign CS2?
A. Yes. InDesign comes with 28 Proximity dictionaries for the following languages: Catalan, Czech*, Danish, 
Dutch, English (Canadian*, UK, USA, USA Legal, and USA Medical), Finnish, French, French Canadian, 
German (Reformed, Swiss, and Traditional), Greek*, Hungarian*, Italian, Norwegian (Bokmal and 
Nynorsk), Polish*, Portuguese, Brazilian Portuguese, Russian*, Slovak*, Spanish: Castilian, Swedish, and 
Turkish*. (Languages marked with an asterisk have been newly added to InDesign CS2.)

Q. Do I need to buy something extra to work on documents in different languages?
A. No. You can easily open and work with files produced in any language version of  InDesign, including 
Japanese, in any other language version of InDesign. So, for example, you could open an Italian document 
in a German version of InDesign, or a Japanese document in an English version of InDesign (see the page 
11 for more details about opening Japanese documents in a Roman language version). In addition, because 
of the built-in dictionaries, you can easily associate a language with a character, a word, a paragraph, or a 
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lengthy piece of text; or you can specify a language as part of a character or paragraph style. Adobe InDe-
sign then uses the appropriate language for spell checking and hyphenation. When you send the docu-
ment to a colleague, client, or service provider, the language dictionaries are embedded with the file so the 
hyphenation remains consistent on different systems.

Q. How does InDesign differ from other page layout applications in its support for Japanese typography 
and layout?
A. Adobe InDesign is designed for professional Japanese publishing, delivering true Japanese page layout 
and exacting typographical control on the desktop. In the past, Roman page layout applications have made 
few accommodations to the precision of Japanese design. For example, all localized versions of Roman 
page layout software have included built-in Japanese type controls, but these controls have been completely 
inadequate because the underlying typesetting metaphor is different. In Roman software, type is laid out on 
a baseline. Japanese text, on the other hand, has no concept of a baseline and instead positions text in rela-
tion to its center point. Because InDesign is easy to customize, we could easily replace the Western-oriented 
type engine with one that supports high-quality Japanese typography. We could also extend the page layout 
functionality to support a real Japanese page design workflow. Here are a few of the key InDesign features 
that support Japanese publishing:

• Japanese layout grids—Maintain a traditional Japanese layout workflow by defining character-based page 
grids for precisely positioning objects and text frames. Then save them as templates.

• Frame grids and frame direction—Use frame grids with text to precisely position text based on Japanese font 
metriCS2. Set up frame grids with a horizontal or vertical orientation, and switch directions at any time. 
Also display the character count for any frame grid, and track how many characters are overflowing it.

• Mojikumi—Create and edit customized character-spacing rule sets using flexible controls. Or, select pre-
defined sets of character-spacing rules.

• Measurement systems—Specify or convert measurements with unparalleled accuracy, whether you’re work-
ing in millimeters, Ha and Kyu, traditional Western points and picas, or other measurement systems.

• Customizable typographical controls—Use, create, or edit Kinsoku Shori rules. Combine different fonts 
into a single composite font. Easily set Ruby and Kenten. Select vertical characters and quickly change their 
orientation to horizontal with automated Tate-chu-yoko controls. Edit Japanese hanging punctuation rules 
to suit your designs.  

Q. Will a Japanese version of Adobe InCopy CS2 be available?
A. Yes, Adobe will be introducing a Japanese version of InCopy CS2. This professional writing and editing 
program will integrate tightly with the Japanese version of InDesign CS2, empowering designers and editors 
to work in parallel on the same design document. InCopy CS2 fully supports Japanese typography, includ-
ing SING Gaiji glyphlets used in an InDesign layout, so editors can work with 100% accurate information 
as they write, edit, and copyfit text. In addition, InCopy provides highly productive editorial tools to help 
editors prepare copy more efficiently for publication. Together, InCopy CS2 and InDesign CS2 introduce a 
revolutionary new collaborative editorial workflow to professional Japanese publishing.

Q. What is Adobe SING Gaiji and how does it work with Adobe applications?
A. High-quality Chinese, Japanese, and Korean (CJK) typography requires an open-ended class of Chinese-
derived characters. Different CJK fonts provide a core selection of these characters as part of their standard 
character set. However, publishers often need supplemental glyphs or characters that are known as “gaiji.” 
Gaiji is a Japanese word that refers to any glyph that’s valid in your written language but is not in the font 
you are using. 

The Adobe SING architecture enables you to extend your CJK fonts with individual new “glyphlets,” rep-
resenting variant glyph shapes or symbols. These glyphlets are embedded in documents. This means that 
anyone at any point in the workflow can edit documents using the embedded glyphlets without having to 
install them on their system. The SING architecture solves a critical layout problem, so designers and pub-
lishers can take advantage of the power and cost-effectiveness of desktop design systems without sacrificing 
typographic flexibility. The SING architecture also opens opportunities for font, IME, and other developers.
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For years, proprietary CJK publishing systems have had an edge over desktop systems because of the quality 
of their typography and the ease with which they could create and manage gaiji characters. Adobe and other 
industry leaders addressed many CJK typography requirements with the introduction of Unicode support 
and the OpenType® font standard. Adobe also built robust support for Japanese typography into Japanese 
versions of InDesign, InCopy, Illustrator, and other Adobe products. Now built-in support for Adobe SING 
Gaiji rounds out the requirements for achieving high-quality Japanese typography on the desktop. 

Q. Can the Roman and Japanese versions of InDesign share files?
A. Yes. As noted previously in this document, the Roman and Japanese versions of Adobe InDesign CS2 
share a common file format, so you can open and modify Japanese layouts in Roman versions of InDesign 
CS2 and Roman files in a Japanese version of InDesign CS2. However, the Roman versions of InDesign CS2 
do not have the typographical, layout grid, and frame grid tools for editing Japanese text that are available in 
the Japanese version. 
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